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1. PDFMarkz App Overview
Here’s some sample videos showing PDFMarkz in action

Here’s a link to a Quick Start video showing PDFMarkz in action

Here’s a link to a movie showing how to extract images out of your PDF file. Once extracted you can re-use
them in other projects you are working on.

PDFMarkz is a standalone application for Apple’s macOS 10.12 and higher that can open and preview PDF
files and then convert them to different formats. PDFMarkz also has some handy desktop workflow features
built in so you can open the converted PDF file in other applications you may use in your everyday workflow.

Following are some of the features PDFMarkz will add to your digital toolbox -

1. An Inspector Panel which is like a light preflight overview of your PDF document
2. Ability to open an IDML version of your PDF in InDesign, QuarkXPress (2017 or later) or Affinity

Publisher 1.8 or greater
3. The ability to export your PDF document as IDML. PDF, TIFF, PNG, JPEG, GIF or export the text

from your file.
4. Ability to open multiple files at one time
5. Ability to select an application to open your converted file, either manually or as a more permanent

workflow feature.
6. Exported PDFs have editable text (as long as the original PDF contained editable text)
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2. PDFMarkz Quick Start Guide
PDFMarkz is a standalone application currently available for macOS 10.12 and higher.

PDFMarkz converts PDF files to several different formats, but mainly too IDML. This allows you to convert
you single or multipage PDF files to InDesign, Quark or Affinity Publisher. In addition, PDFMarkz can extract
the text and images out of your PDF files.

Here’s a link to a Quick Start video showing PDFMarkz in action

Here’s a link to a movie showing how to extract images out of your PDF file. Once extracted you can re-use
them in other projects you are working on.

The steps below are different than the movie, but if followed show a few different features than the movie.

1. Download PDFMarkz
2. Install PDFMarkz (download the .dmg file, double-click the .dmg and then drag-and-drop the

PDFMarkz application into your Applications folder)
3. Activate PDFMarkz
4. Register PDFMarkz
5. Use Command-O or Drag a file onto the window to open a file
6. Use Command – +/- to Zoom in and out of the preview
7. Use Command-0 to zoom preview back to full page
8. Command-I to toggle the Inspector Panel on or off and see an overview of the fonts, colors and other

document attributes.
9. Click on Export and select PNG to export the entire document as a series of PNG files, one PNG

image per page
10. Click on Open in InDesign to open and IDML version of your PDF file in InDesign (a PDF to InDesign

conversion path designed as a replacement for Markzware’s PDF2DTP Plug-Ins)
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3. PDFMarkz System Requirements
• macOS 10.12 or higher
• 4GB RAM recommended
• 1 GB free disk space minimum
• Internet Connection to Activate and view online User Manual
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4. PDFMarkz Installation
1. Make sure you are connected to the internet
2. Download the PDFMarkz DMG file located at – PDFMarkz
3. Double-Click on the DMG, this will bring up a Drag-n-Drop Installer Window
4. Drag the PDFMarkz application to the Applications Folder Alias on the Drag-n-Drop screen

5. Start up PDFMarkz
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5. PDFMarkz Activation
1. Enter the email address that was used to purchase PDFMarkz. Please make sure you are connected

to the internet when attempting to activate PDFMarkz.

2. Copy and paste your PDFMarkz License into the provided area

3. Click – Activate
4. PDFMarkz will attempt to Activate

5. PDFMarkz successfully Activates
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6. Close the Activation Window by clicking on the red lollypop dot in the upper left corner
7. You are now ready to tap into all of features PDFMarkz has to offer
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6. PDFMarkz Registration
1. After activating PDFMarkz the first time, you will have the ability to register the product, by clicking

on the Register button

2. Fill in the Registration screen and click Register to submit your registration information.

3. You will next see a registration complete message.
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4. You can now begin using PDFMarkz.
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7. PDFMarkz Startup Window
When you first start up PDFMarkz you will see the Startup Window. This is the main window for PDFMarkz.

From this Window you can open files to preview in PDFMarkz. Files can be opened in one of four ways

1. Navigate to the PDFMarkz file Menu and select Open to choose a file to open.
2. Clicking Command-O will bring up an Open File window where you can select files to preview and/or

convert.
3. You can drag files onto the Drop zone
4. Clicking on the Open Files button on the Get Started Window will also bring up a File Open window

where you can select files to preview and/or convert.
5. The lower part of the Startup Window shows information about available tutorials and other
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Markzware products.
6. At the lower left of the window is a checkbox which allows you to either show this window every time

you launch PDFMarkz or not show the window.
If you elect not to show the Let’s Get Started Window, you simply need to do Command-O to select
files to open in PDFMarkz.
If you have disabled Show Window on Launch, but would like to use the Startup Window to drag files
onto, you can bring it back up clicking Command-; (Command-Semicolon). The Startup window will
now be visible once again.
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8. PDFMarkz Preview Window
Once you open a file in PDFMarkz, you will see a Preview Window. This window has the following features -

1. At the very top is the document title of the currently active document
2. To the right of the document title is the document type (which should always be PDF)
3. Underneath the title are the Export Button, Open In buttons and the Print button.The Export options

allow you to export and or open the currently previewed file in other applications in just a few clicks.
The Open In buttons allow you to open the currently previewed file in other applications with a single
click.

4. Just below the Export and Open In buttons is the title of your document. If you have Tabs enabled this
area will show the names of all open documents in tabs. The currently active preview will be
highlighted. (See General Preferences for Setting up viewing files using Tabs).
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5. The main preview of your document is the large left portion of the window and is the largest visible
area.

6. To the right of the Main preview is the Thumbnail Preview area. Here you can scroll through
Thumbnails and then by clicking on a thumbnail, go directly to the preview of that page in the left hand
main preview area.

7. Directly underneath the Preview you will see the dimensions of the document.
8. At the bottom left you will see information about the pages and spreads in your your document.
9. At the bottom right is a magnification slider that adjusts the size of the main preview. There are also

shortcut keys to adjust this zoom level.
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9. Unknown Characters Editor
Sometimes PDFs when viewed show a bunch of tildes (~) instead of actual text. The situation occurs when
fonts contain unknown “glyphs” or shapes that represent a character. Adobe Acrobat Pro or DC contains
what is known as OCR technology (OCR = Optical Character Recognition) which scans the shapes and then
attempts to match them up with known letters.

PDFMarkz does not contain an OCR engine and thus you see the Unknown Characters Editor window
popup. When it does pop up, you have a few choices of what you can do. (Some choices are much better
than others)

First – you can always click on the Cancel button. This will close the Unknown Characters Editor window
and also close the PDF you were trying to open. This will not replace any of the tildes with known
characters.

Second – You can click on Continue WITHOUT editing any of the Unknown Characters. This will in
99.9999% of cases bring up a preview of the PDF with a lot of the text replaced with ~’s. (not the best
choice to make)

Markzware PDFMarkz User Guide - 1_en

©2022 Markzware Page 14 of 94



Third – You can edit the Unknown Characters. This is a manual process and can take a bit if time
depending on how many Unknown Characters are contained in your PDF. But the process can move along
quickly as the Unknown Characters Editor is designed to streamline entering the character data.

Markzware PDFMarkz User Guide - 1_en

©2022 Markzware Page 15 of 94



Following is a sample of a before and after of the same document. As you can see having a page full of
tildes (~) is not very useful. Once you edit the Unknown characters, and then click the Continue button, your
document will now appear with the substituted characters thus creating readable text.
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A few words or caution – If you see odd looking words that are spelled incorrectly, most
likely you entered in incorrect values while editing the Unknown Characters. For example, if
you accidentally entered in the letter “o” where the letter “a” should be, when you open the
document, words like apple, or at would show as opple or ot. To address this issue, click
on the Tools Menu and select Unknown Characters Editor this will bring back up the
Unknown Characters Editor and you can then replace the characters that are incorrect.
Once finished editing, click on the Continue button in the Unknown Characters Editor to see
the changes applied to your PDF.

!
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9.1. PDFMarkz Entering Characters with
Diacritical Marks
For letters that use diacritical marks, once in the cell to edit the character, simply long-press the letter
on the keyboard and a popup menu will appear with choices of what characters are available. You can
then either use the right and left arrow keys to select the character you want or you can simply type the
number under the character in the list. In the sample screen cap, the “e” was long-pressed until the
popup menu appeared. At this point you can either use the right arrow key to navigate to the é and then
tap Return or you can simply type the number 2, which highlights the é entry and tap the Return key.
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9.2. PDFMarkz Entering the Trademark
Symbol
You can also enter special characters like ™ or ©

What if you don’t know the keyboard shortcuts for these characters? Well, you can use Apple’s handy
Keyboard Viewer. This can be configured and enabled under the Apple System Preferences.

Once configured you should see a flag or icon in your Main Toolbar with the input source showing. In
this case, since Markzware is based in the U.S., you see an American flag and the letters U.S. in the

To get easy access to this feature, make sure and check the “Show input menu in menu
bar” checkbox.*
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toolbar. The sample screen cap also shows switching to the Australian keyboard input, where you now see
an Australian flag instead of a U.S. flag.

How to get the trademark™ symbol
Make sure the cursor is in the proper cell in the Unknown Characters Editor
To start – Bring up the Keyboard Viewer

1. Hold down the Option Key. Now look for the ™ symbol. Notice that it is the same key as the “2” key
2. Now press the key combination of Option-2 and you will see the ™ appear in the character cell in the

Unknown Characters Editor window. The border of the cell will now turn to a thin green line, indicating
the contents of the cell have been edited.

The Unknown Characters Editor does not check for a match or the correctness of the data
you enter in each cell.

!
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9.3. PDFMarkz entering Emoji & other
Symbols

How to get emojis and other symbols
Under the same menu used to bring up the Keyboard Viewer, now, select “Show Emoji & Symbols”. This
brings up another window called the Character Viewer window.

Make sure the cursor is in the proper cell in the Unknown Characters Editor
Double-click on the emoji or symbol you want to appear in the cell as a replacement character.

*Tip *- You can use this feature to replace certain characters with other characters. For
example you may want a diamond bullet character instead of a round bullet character. To
do this, when you encounter a round bullet character in the Unknown Characters Editor,
*
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simply replace it with the diamond bullet character and when you view your document, all of
the round bullets should now be replaced with diamond shaped bullets. (This replaces • with
◆)

Markzware PDFMarkz User Guide - 1_en

©2022 Markzware Page 22 of 94



9.4. PDFMarkz Entering Hexadecimal values

How to enter Hex Values for Characters
Finally, if you know the hexadecimal values of characters you can enter in their hex value by typing 0x
followed by the four-digit hex value. For example, a lower case “a” is typically 0x0061.

0x0061 means typing in – zero-x-zero-zero-six-one*
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10. PDFMarkz Menus Overview
• PDFMarkz Main Menu Bar

1. PDFMarkz
2. File
3. Edit
4. View
5. Window
6. Help

• PDFMarkz Inspector Panel
• PDFMarkz Shortcut Keys
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10.1. PDFMarkz Menu
About PDFMarkz

Brings up the About Window which shows

1. The Version of PDFMarkz
2. Your License ID if you have purchased the full version of PDFMarkz
3. The Status of PDFMarkz (Activated or Freebie)
4. The Expiration information for your PDFMarkz License

Preferences

Displays the PDFMarkz Preferences Window (see the PDFMarkz Preferences section for details).

Services

Displays Services provided by the macOS and other Applications that have registered with the macOS.

Hide PDFMarkz

Hides the PDFMarkz Application and all of its open windows. To Unhide PDFMarkz, click on the
PDFMarkz icon in your macOS Dock, or do Command-Tab and select the PDFMarkz icon.

Hide Others

Hides all open application windows except PDFMarkz

Show All

This shows all hidden apps and windows (essentially the reverse of Hide Others)

Markzware PDFMarkz User Guide - 1_en

©2022 Markzware Page 25 of 94



Quit PDFMarkz

Quits the PDFMarkz application
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10.2. PDFMarkz File Menu
Open

Brings up an Open File Dialog Window where you can select one or more PDF files to open.

Open Recent

Shows a list of recently opened files in case you need to re-open them again without hunting for them on
your computer system.

Convert to IDML…

This menu item allows you to select a PDF to convert directly to IDML without showing the Preview on
screen. There are a few things that work differently about this menu item -

1. This feature does not work with files listed in the Open Recent files menu. You must select a file to
convert from the Choose a supported file to convert to IDML window.

2. You cannot change the path the IDML is created at, it will always be in the same folder as the file you
select

Close

Closes an open file. Or, if you have multiple files open, will close the active file.

Export

Brings up the Export Window. This window can also be accessed by clicking on the Export icon on the
document window toolbar.

Export as IDML…

Brings up a window asking you where to Save the IDML file. Once you select a location, clicking the
Export button will export an IDML of the active document to that location.

Export as PDF…

Brings up a window asking you where to Save the PDF file. Once you select a location, clicking the Export
button will export your original PDF document to that location.

Share…

Pops up a Share Window where you can select where to share your file. The contents of the Share Menu
are based on what you have setup under the macOS Preferences under Extensions/Share Menu. This is
unique to each User’s system.
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Open in

These menu item selections allow you to open the active document in one of the following applications,
providing the application is properly loaded and licensed on your computer system.

Adobe InDesign – Selecting Open in InDesign will create an IDML of your PDF file and attempt to open
it in the Default version of InDesign set in your macOS. In order for this to work, you must have a
version of InDesign loaded on your computer and it must be InDesign CS4 or higher, as CS4 was the
first version of InDesign that supported IDML.

QuarkXPress – PDFMarkz creates an IDML file of your PDF file and then sends the IDML to
QuarkXPress. This requires Quark 2017 or later in order to work as earlier versions of Quark had no
support for IDML files.

Affinity Publisher – Selecting Open in Publisher will create an IDML of your PDF file and attempt to
open it in Affinity Publisher. In order for this to work you need to be using Affinity Publisher 1.8 or later
as version 1.7 and below do not support IDML files.

Adobe Acrobat – Selecting Open in Adobe Acrobat will pass your original PDF to Acrobat.

Adobe Illustrator – Selecting Open in Illustrator will pass your original PDF to Adobe Illustrator.

Print…

Selecting Print will bring up a standard macOS Print Dialog allowing you to print a hard copy to your
printer.

PDF to InDesign conversion was previously handled by Markzware’s PDF2DTP InDesign
Plug-Ins. Thus, PDFMarkz is the replacement product for PDF2DTP.*
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10.3. PDFMarkz Edit Menu
These items are only available when working with the About Screen to Activate or Deactivate PDFMarkz
and when Registering PDFMarkz.

Cut

Copy

Paste

Select All

If you try and edit an open document, these items will not work as they will be grayed out.!
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10.4. PDFMarkz View Menu
Hide Tab Bar

This only works if a single document is open. If you have multiple documents open Hide Tab Bar is grayed
out and not available.

Show All Tabs/Exit Tab Overview

This only has an effect when you have enabled “Prefer Tabs when Opening Documents” under the
General Preferences. With Tabbed viewing enabled, selecting Show All Tabs, displays a thumbnail of all
open documents in a the main preview area, this allows you to get a quick overview of which document
you currently have open and by clicking on a tab view thumbnail, you can switch to that document. When
you double-click on a thumbnail to view it, the PDFMarkz window is expanded to take up your entire
screen, but you are not in Full Screen Mode.

Show Toolbar/Hide Toolbar

Clicking on this shows or hides the toolbar area. The toolbar area is the area at the top of the preview
area that contains icons for Exporting and Opening your PDF file in other applications.

Customize Toolbar…

Selecting Customize Toolbar opens up a window where you can re-arrange and customize the toolbar to
suit your particular method of working.

Zoom In

Magnifies the document displayed in the current active window.

Zoom Out

Reduces the display size of the document displayed in the current active window.

Fit Page in Window

Fits the current displayed page into the display area of the current active window

Fit Spread in Window

If facing pages were used when the document was created, this will fit the spread into the display area of
the current active window.

If you want a smaller window, you will need to manually resize the window.
If you go into Full Screen Mode, tap the Esc Key to return to a smaller window size.*
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Actual Size

Will zoom the document to full size. You may have to pan around the view in order to see the area you
are interested in viewing, as Actual Size in many cases makes the preview larger than the current display
window. Currently you must use the scroll bars located on the bottom and right of the document display to
pan the document or the scroll feature on your mouse or other input device.

Next Spread

Will navigate to the next spread (if PDF was saved with spreads)

Previous Spread

Will navigate to the previous spread (if PDF was saved with spreads)

Toggle Inspector

Toggles the Inspector Window on or off. The Inspector Panel is like a light preflight inventory of the
current active document. Each document will have its own Inspector Window.

Enter Full Screen

Will take the PDFMarkz application into Full Screen Mode. To exit Full Screen Mode, tap the Escape Key.
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10.5. PDFMarkz Tools Menu
The Tools Menu allows you to bring up the PDFMarkz Unknown Characters Editor or the Script Installer.

This allows you to make edits to character data you have previously entered into the Unknown Characters
Editor without having to close and re-open the file if it is currently open.

This allows you to disable the Launch when scripts available checkbox on the Scripts Installer window, you
can always bring the window back up to review the status of installed PDFMarkz scripts. Bringing up the
Script Installer window also allows you to see what scripts are currently installed.
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10.6. PDFMarkz Window Menu
Minimize

Will minimize the current document window to your Dock. To view the window again, either click on the
icon in your Doc or under the Window menu select the name of the document and click on it.

Zoom

Zooms PDFMarkz to fill up your entire screen. Selecting Zoom a second time will bring the PDFMarkz
window back to its original size. If you wish to resize the window, you must grab the lower right corner and
drag to resize the window.

Show Previous Tab

If tabbed windows is enabled, this moves to the tab on the left. If you are viewing the document
associated with the left most tab, this will cycle around and go to the farthest tab on the right.

Show Next Tab

If tabbed windows is enabled, this moves to the tab on the right. If you are viewing the document
associated with the right most tab, this will cycle around and go to the farthest tab on the left.

Move Tab to New Window

This will take the current selected document and move it to a new floating window that it is no longer part
of the tabbed window. You may position this window anywhere on your screen.

Merge All Windows

This will merge all open documents into a single tabbed window.

Show Get Started Window

Will show the Get Started Window which is the initial window that shows when you first start up
PDFMarkz. The Get Started Window allows you to open up files. It also displays info about tutorials and
help for PDFMarkz. (If the Get Started Window is already open, this will do nothing.)

Bring All to Front

Will bring all open PDFMarkz windows to the front. As an example if you have a browser window open
and it is between two PDFMarkz windows, the browser window will be placed behind the two PDFMarkz
windows, thus making PDFMarkz the front most app and the app that is in focus for the macOS.
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10.7. PDFMarkz Help Menu
Search

Built in macOS search provided by Apple (this does not tie into PDFMarkz documentation)

User Guide…

Will take you to the online PDFMarkz User Guide. The online User Guide is fully searchable. If you cannot
find a topic in the online User Guide, please post feedback using the link on the bottom of each page. If
you want a PDF version of the User Manual you can scroll down to the bottom of the Table of Contents
and click on the Download as PDF button.

Online Tutorials…

Will bring up online tutorials for the PDFMarkz product.

Report an issue…

Will bring up Markzware’s Online Trouble Ticket with your PDFMarkz License ID already filled in. Please
describe your issue and if needed, please upload sample files, screen shots or movies so we can
review your issue and contact you. The Online Tech Support Form has an area where you can upload
files. If you have more than one file, please create a ZIP archive containing all files you wish to upload,
then upload just the single ZIP archive.

If you encounter a problem converting a file, please upload the file for us to look at. We
cannot begin to address an issue if you just upload a screen capture and say there is
something wrong with conversion. Thus, the original PDF is needed by our Tech Support
and Engineering people to begin the process of troubleshooting and fixing.

*

Markzware PDFMarkz User Guide - 1_en

©2022 Markzware Page 34 of 94



10.8. PDFMarkz Inspector Panel
The Inspector Panel is an overview of your document. It displays a mini inventory of what comprises your
document.
Each document has its own Inspector Panel Window.

Some features of the Inspector Panel

• Can be set to show up automatically every time you open a file (found under the General Preferences
Tab)

• Can be opened and closed using Command-I
• Can be dragged to any location on the screen, but if you drag it onto a second screen it will snap back

to the upper middle of the Preview Window.
• The Inspector Panel will follow the main preview window, thus where ever you position it on screen,

when you move the main preview window, the Inspector Panel will follow.

Following is a breakdown of each section of the Inspector Panel

1. (ICON) PDF file is associated with
2. Name of the document
3. Document Type
4. File Size of the document on disk
5. Document Creation Date
6. Document Last Modified Date
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PDFMarkz Inspector - File Info

1. Number of Pages
2. Number of Spreads
3. Whether document uses Facing or Non-Facing Pages
4. Dimensions of the Document

PDFMarkz Inspector - Page Info

1. How many fonts are used in the job
2. How many fonts are missing
3. How many fonts are inactive

PDFMarkz Inspector - Font Info
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1. Number of colors associated with the document
2. Used – how many colors are detected as being used in the document.

PDFMarkz Inspector - Color Info

1. Total number of images detected in the document
2. Number of images detected as missing
3. Number of images detected as embedded (these could be images that were copied and pasted into a

document).

PDFMarkz Inspector - Image Info

1. Number of Stories detected in the document.

PDFMarkz Inspector - Story Info

Since PDFs are rendered, the document colorspace plus any spot colors is what will be
reflected in the color usage area

!
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The number of stories is a number created by PDFMarkz as PDFs do not contain story data.
So the number you see is based on how PDFMarkz sees text in the PDF.*

Markzware PDFMarkz User Guide - 1_en

©2022 Markzware Page 38 of 94



10.9. PDFMarkz Shortcut Keys
PDFMarkz Menu

Command – Comma (,) Open PDFMarkz Preferences

Command – H Hide PDFMarkz

Option-Command – H Hide Others (other Applications)

Command – Q Quit PDFMarkz

File Menu

Command – O Open a File for Preview

Shift-Command-O Convert to IDML (without creating a preview)

Command -W Close active open file

Command – E Open Export Menu

Option-Command – I Export as IDML

Option-Command – P Export as PDF

Command – P Print current active file

Edit Menu
These commands only work when Activating, Registering or Modifying
PDFMarkz Preference Values. PDFMarkz does not support editing of the
current open document(s)

Command – X Cut Selected content and place on macOS Pasteboard

Command – C Copy Selected content and place on macOS Pasteboard

Command – V Paste content from the macOS Pasteboard

Command – A Select all content in the current active text or input area

View Menu

Shift-Command-Backslash (\)
Show all Tabs (if Tabbed viewing is enabled) by presenting them as small
Thumbnails

Option-Command – T Show/Hide Toolbar

Command-Equal (=) Zoom In

Command-Minus (-) Zoom Out

Command-Zero Fit Page in Window

Shift-Command-Zero Fit Spread in Window
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Command-One (1) Show document at actual size

Command – I Toggle Inspector Panel on or off

Control-Command – F Toggle Full Screen Mode on or off

Window Menu

Command – M Minimize PDFMarkz

Control-Shift-Tab Show Previous Tab (must have Tabbed Viewing Enabled)

Control-Tab Show Next Tab (must have Tabbed Viewing Enabled)

Command-Semi-Colon (;) Show PDFMarkz Get Started Window
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11. PDFMarkz Scripts
PDFMarkz ships with some scripts that add menu items to InDesign for converting PDFs files to InDesign.
The scripts are designed to closely approximate how Markzware’s PDF2DTP InDesign product worked and
allow you to convert PDF files to InDesign without ever leaving the InDesign environment.

Here’s a link to a movie showing how to install and use the PDFMarkz scripts for InDesign.

Installing the Scripts
Setting System Prefs on Mac for Scripts
Running the Scripts
Uninstalling the Scripts
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11.1. PDFMarkz – Installing Scripts
After activating PDFMarkz, the first time you start the application, you will see a Scripts Installer Window.
The Window will list all versions of InDesign from CS6 and higher it finds on your computer that are located
in your Applications Folder. Next to each version of InDesign listed is an Install Button. Clicking on the
Install Button will install the PDFMarkz scripts into that version of InDesign.

At the lower left of the Scripts Installer Window is a checkbox that lets you hide the Window if there are
scripts still available for install on relaunch of PDFMarkz. If you uncheck Launch when scripts available, you
can always access this window anytime PDFMarkz is open by going to the Tools Menu and selecting Script
Installer.

Before installing any of the PDFMarkz Scripts, please make sure that version of InDesign is
not running, otherwise you will need to restart InDesign to access the scripts.*
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11.2. PDFMarkz – Setting System Prefs on
Mac for Scripts
If your scripts fail to run, this is most likely an issue with the macOS Security and Privacy Preferences. You
should be able to remedy this problem by doing the following -

1. Bring up your Mac System Preferences Window
2. Select the Security & Privacy Preference
3. Select the Privacy Tab
4. Scroll down until you see Automation
5. Enable the Finder Checkbox under Adobe InDesign 2020.app (or the latest version of InDesign you

see listed under the Automation area).

If you are encountering issues running the PDFMarkz scripts from within InDesign because you are unable
to manually add InDesign to the Privacy – Automation area, please checkout the following video that shows
a workaround by using an older version of InDesign to automatically make the entry for you.

Movie showing how to add InDesign back into the Privacy – Automation area

Hint – If you need to load InDesign 2020 on your system, you may want to consider keeping
it loaded as based on history, Adobe now only allows the currently released version of
InDesign and the previous version of InDesign to be installed through your Creative Cloud
application.

*

Markzware PDFMarkz User Guide - 1_en

©2022 Markzware Page 43 of 94

https://youtu.be/-dEQ4QYiZZ4


Markzware PDFMarkz User Guide - 1_en

©2022 Markzware Page 44 of 94



11.3. PDFMarkz – Running The Scripts
Once you install the scripts, the following two new items are available in InDesign

In the Main Manu Bar for InDesign you will see a new entry named Markzware. Under this menu will be an
item named Convert PDF Document…

Clicking on Convert PDF Document… will bring a window where you can choose a PDF document to
convert to InDesign. Once the conversion is complete you will now have a new InDesign document that you
can edit and make changes too. Please remember to Save your InDesign document before doing too many
changes to it.

Under the File Menu a new item will appear named Open PDF File… This will allow you to choose a PDF
file to open and convert to InDesign.
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11.4. PDFMarkz Uninstalling the Scripts
To uninstall the PDFMarkz scripts -

1. Make sure InDesign is not running
2. Navigate to your Adobe InDesign folder
3. Navigate to the Scripts folder
4. Delete the Markzware folder
5. When you restart InDesign the scripts will no longer be available, but the Markzware Menu will still be

present.

You still need to remove the Markzware Menu Item

To remove the Markzware Menu from InDesign’s Main Menu Bar

1. Download the RemoveMarkzwareMenu script
2. Open up the InDesign Scripts Window
3. Right-Click on the User folder and select Reveal in Finder
4. Move the RemoveMarkzwareMenu script into the User/Scripts Panel Folder
5. Switch back to InDesign and run the RemoveMarkzwareMenu script from the Scripts/User area of the

Scripts Panel
6. The Markzware Menu will disappear

Here’s a link to a movie showing how to do all of the above

You can also reset InDesign’s Preferences to remove the Markzware Menu. Resetting
InDesign’s Preferences may be something many Users prefer not to do unless absolutely
required, thus the option of running the RemoveMarkzwareMenu script.
*

Although the movie shows this procedure for QXPMarkz, the process is almost the same for
PDFMarkz , except you will be deleting the PDFMarkz scripts. The portion of the movie
showing how to remove the Markzware menu, is the same for both PDFMarkz and
QXPMarkz.

!
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12. PDFMarkz Open In Options

PDFMarkz Open In Icons
PDFMarkz Open in InDesign
PDFMarkz Open in Quark
PDFMarkz Open in Publisher
PDFMarkz Open in Acrobat
PDFMarkz Open in Illustrator

PDFMarkz Print
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12.1. PDFMarkz Open in InDesign

Open in InDesign attempts to open the currently viewed file in the default version of InDesign set on your
system. If you do not have InDesign loaded on your system, you will see an error message.

In order for this to work, you must be using InDesign CS4 or later, as CS4 was the first version of InDesign
that supported IDML.

If you wish to force PDFMarkz to open InDesign files in a specific version of InDesign, use
either the “Automation Preferences” or the “Export as IDML feature”.

!
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12.2. PDFMarkz Open in Quark

Open in Quark will create an IDML file from your PDF and will then attempt to open it in QuarkXPress 2017
or later.

In order for this to work you must be using QuarkXPress 2017 or later, as earlier versions of
QuarkXPress do not have support for IDML files.

!
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12.3. PDFMarkz Open in Publisher

If you have Affinity Publisher 1.8 or above loaded, Open in Publisher will create an IDML of your
current open file and then attempt to open that IDML in Affinity Publisher. This will be much more
accurate than the PDF workflow for Affinity Publisher 1.7 and earlier.

If you have Affinity Publisher 1.7 or earlier loaded, Open in Publisher will create a PDF of your current open
file and then attempt to open that PDF in Affinity Publisher.

Please be aware that not all features are currently supported in creating a PDF from the
onscreen preview, thus some items may not translate accurately.

!
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12.4. PDFMarkz Open in Acrobat

Open in Acrobat will attempt to open your original PDF in Adobe Acrobat, unless you modify this under the
PDFMarkz Open In Preferences.

This PDF should have editable text unless it was created using a placed bitmap or
rasterized image of text instead of actually text converted to a PDF file.

!
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12.5. PDFMarkz Open in Illustrator

Open in Illustrator will attempt to open your original PDF in Adobe Illustrator. By default, PDFMarkz uses the
Default Version of Illustrator as seen by your Mac Computer.

If you wish to force a PDF to be opened in a specific version of Illustrator, you will need to
set up a mini workflow under the Export PDF icon or you could set up a workflow under the
Automation Preferences area as well.

!
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12.6. PDFMarkz Print

Print will attempt to print the currently active file. Using this feature brings up a standard Apple Print dialog
with all of the normal print features provided by macOS.
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13. PDFMarkz Manual Export Options

PDFMarkz Manual Export Options
PDFMarkz Export
PDFMarkz Export As IDML
PDFMarkz Export As PDF
PDFMarkz Export As TIFF
PDFMarkz Export As PNG
PDFMarkz Export As JPEG
PDFMarkz Export As GIF
PDFMarkz Export Stories
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13.1. PDFMarkz Manual Export Options
Clicking on the Export Icon reveals all of the file formats that can be manually exported by PDFMarkz. While
several of these Export options appear to duplicate the Main icons in the File Preview Window and some of
the Automation Preferences, think of these icons as Mini-Workflows that can be set up and reused for a
specific file type export. These mini-workflows are then a few clicks away.

There is currently only one workflow per file export type available. The settings for each
export icon/file format remain the same until you manually change them.*
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13.2. PDFMarkz Export As IDML

Post Export

1. Open In

Selecting the Open In Checkbox allows you to select which application will handle the exported IDML file.

2. System Default Application

This is the default application your macOS system uses to handle IDML files. If you have InDesign
loaded, it is typically used as the Default application to handle IDML files.

3. Specific Application Path

Selecting this radio button will enable the selection area.

4. Selection area

Click in the selection area to bring up a Standard macOS Finder window allowing you to navigate to
the application you wish to use to handle the exported IDML file. The application you select must be
able to actually handle the IDML, otherwise it will display some form of error message.

Some possible choices for apps would be Adobe InDesign, Affinity Publisher v1.8 and
higher or QuarkXPress QXP 2017 or higher.*
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5. Suppress dialogs when possible

When this box is selected warning and error dialogs in applications the IDML is sent too are
suppressed if possible. These dialogs would typically be things like missing fonts and missing
images.
When opening files in other applications, many times they pop up alert dialogs that require you to
click on something to continue. This can cause unwanted interference or halt in a workflow. The
downside of suppressing these dialogs is you do not know if fonts or images may be missing.

6. Show in Finder

If this box is checked, when you perform the Export as IDML action, once it is completed, your file will be
revealed in a Standard macOS Finder Window. Unless you need to interact with the file immediately after
export in the macOS Finder, this box should be left unchecked. Leaving the box unchecked will also
speed up the export process as a Finder Window will not need to be called and displayed.

7. Close Document

If this box is checked, your file will be closed in PDFMarkz after the IDML file has been exported. By
Default this box is left unchecked and your file remains open in PDFMarkz until you manually decide to
close the file.

8. Cancel Button

Clicking the Cancel button will cancel the IDML export action and close the IDML Export Pane. This will
take you back to the main File View Window in PDFMarkz.

9. Export Button

Clicking the Export button will export an IDML of the currently active file using the settings you have
selected in this Export IDML Panel. When you click on Export this will also bring up a Standard macOS
Finder window asking you where you would like to Save your IDML file.
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13.3. PDFMarkz Export As PDF

Pages

1. All

Exports all pages in the document

2. From X to X

Allows you to select a continuous range of pages to export.
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3. As Pages or Spreads

3A. Pages

will export each page in the document as a separate page (no spreads)

3B. Spreads

If the original document was created using Facing Pages, then Spreads will be created in the PDF. If
the original file was created without Facing Pages, selecting Spreads has no effect and the PDF will not
contain spreads.

4. Separate Files

If checked, each page will will export as a separate PDF. If Spreads are selected, then each spread will
be a separate file.

5. Suppress Enclosing Folder

If checked will create the PDF files loose in the selected folder instead of creating an enclosing folder
for each PDF job. This may come in handy if you want to create PDFs of several jobs and have them all
be in the same folder instead of separate sub-folders.

6. Transparent Background

Solid White background areas are exported as transparent.

Post Export

7. Open In

Selecting the Open In Checkbox allows you to select which application will handle the exported PDF
file.

8. System Default Application

This is the default application your macOS system uses to handle PDF files. On macOS systems this
is typically either Apple’s Preview application or Adobe Acrobat.

Note – gradients are not supported for this feature, only solid white areas, which are
typically the background of the page. (For example, black text on a white page exported
with a transparent background would export the white page background as transparent.)

!
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9. Specific Application Path

Selecting this radio button will enable the selection area.

10. Selection area

Click in the selection area to bring up a Standard macOS Finder window allowing you to navigate to
the application you wish to use to handle the exported PDF file. The application you select must be
able to actually handle the PDF, otherwise it will display some form of error message. Some possible
apps to select would be Adobe Acrobat, Adobe Illustrator, Affinity Designer, or Apple’s Preview
application.

11. Suppress dialogs when possible

When this box is selected warning and error dialogs in applications the PDF is sent too are
suppressed if possible. These dialogs would typically be things like missing fonts.
When opening files in other applications, many times they pop up alert dialogs that require you to
click on something to continue. This can cause unwanted interference or halt in a workflow. The
downside of suppressing these dialogs is you do not know if fonts or images may be missing.

12. Show in Finder

If this box is checked, when you perform the Export as PDF action, once it is completed, your file will be
revealed in a Standard macOS Finder Window. Unless you need to interact with the file immediately after
export in the macOS Finder, this box should be left unchecked. Leaving the box unchecked will also
speed up the export process as a Finder Window will not need to be called and displayed.

13. Close Document

If this box is checked, your file will be closed in PDFMarkz after the PDF file has been exported. By
Default this box is left unchecked and your file remains open in PDFMarkz until you manually decide to
close the file.

14. Cancel Button

Clicking the Cancel button will cancel the PDF export action and close the PDF Export Pane. This will
take you back to the main File View Window in PDFMarkz.

15. Export Button

Clicking the Export button will export a PDF of the currently active file using the settings you have
selected in this Export PDF Panel. When you click on Export this will also bring up a Standard macOS
Finder window asking you where you would like to Save your PDF file.
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The Exported PDF is not the original PDF, it is a brand new PDF created by PDFMarkz
which matches the Preview PDFMarkz produces. Thus you may see differences between
the original PDF and any PDFs exported out of PDFMarkz.
*
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13.4. PDFMarkz Export As TIFF

Pages

1. All

Exports all pages in the document

2. From X to X

Allows you to select a continuous range of pages to export.

3. Transparent Background

Solid White background areas are exported as transparent.

Note – gradients are not supported for this feature, only solid white areas, which are
typically the background of the page. (For example, black text on a white page exported
with a transparent background would export the white page background as transparent.)

!
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Post Export

4. Open In

Selecting the Open In Checkbox allows you to select which application will handle the exported TIFF file.

5. System Default Application

This is the default application your macOS system uses to handle TIFF files. On macOS systems this
is typically either Apple’s Preview application, Adobe Photoshop or Affinity Photo.

6. Specific Application Path

Selecting this radio button will enable the selection area.

7. Selection area

Click in the selection area to bring up a Standard macOS Finder window allowing you to navigate to
the application you wish to use to handle the exported TIFF file. If you wish to edit the TIFF, some
likely apps you would use on Mac would be Adobe Photoshop or Affinity Photo.

8. Suppress dialogs when possible

When this box is selected warning and error dialogs in applications the TIFF is sent too are
suppressed if possible. These dialogs would typically be things like missing fonts.
When opening files in other applications, many times they pop up alert dialogs that require you to
click on something to continue. This can cause unwanted interference or halt in a workflow. The
downside of suppressing these dialogs is you do not know if fonts or images may be missing.

9. Show in Finder

If this box is checked, when you perform the Export as TIFF action, once it is completed, your file will be
revealed in a Standard macOS Finder Window. Unless you need to interact with the file immediately after
export in the macOS Finder, this box should be left unchecked. Leaving the box unchecked will also
speed up the export process as a Finder Window will not need to be called and displayed.

10. Close Document

If this box is checked, your file will be closed in PDFMarkz after the TIFF file has been exported. By
Default this box is left unchecked and your file remains open in PDFMarkz until you manually decide to
close the file.

11. Cancel Button

Clicking the Cancel button will cancel the TIFF export action and close the TIFF Export Pane. This will
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take you back to the main File View Window in PDFMarkz.

12. Export Button

Clicking the Export button will export a TIFF of the currently active file using the settings you have
selected in this Export TIFF Panel. When you click on Export this will also bring up a Standard macOS
Finder window asking you where you would like to Save your TIFF file.

If your PDF has more than one page, each page will be exported as a separate TIFF file.
For example if you have 6 page PDF file and you select to open in Photoshop, Photoshop
2021 will show you the last page, but when you look under the Window Menu in Photoshop
you will see 5 additional TIFF files for the other pages.

*

Markzware PDFMarkz User Guide - 1_en

©2022 Markzware Page 64 of 94



13.5. PDFMarkz Export As PNG

Pages

1. All

Exports all pages in the document

2. From X to X

Allows you to select a continuous range of pages to export.

3. Transparent Background

Solid White background areas are exported as transparent.

Note – gradients are not supported for this feature, only solid white areas, which are
typically the background of the page. (For example, black text on a white page exported
with a transparent background would export the white page background as transparent.)

!
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Post Export

4. Open In

Selecting the Open In Checkbox allows you to select which application will handle the
exported PNG file.

5. System Default Application

This is the default application your macOS system uses to handle PNG files. On macOS systems this
is typically either Apple’s Preview application or Adobe Photoshop.

6. Specific Application Path

Selecting this radio button will enable the selection area.

7. Selection area

Click in the selection area to bring up a Standard macOS Finder window allowing you to navigate to
the application you wish to use to handle the exported PNG file. If you wish to edit the PNG, some
likely apps you would use on Mac would be Adobe Photoshop or Affinity Photo.

8. Suppress dialogs when possible

When this box is selected warning and error dialogs in applications the PNG is sent too are
suppressed if possible.
When opening files in other applications, many times they pop up alert dialogs that require you to
click on something to continue. This can cause unwanted interference or halt in a workflow. The
downside of suppressing these dialogs is you may not know if problems were detected in the file.

9. Show in Finder

If this box is checked, when you perform the Export as PNG action, once it is completed, your file will be
revealed in a Standard macOS Finder Window. Unless you need to interact with the file immediately after
export in the macOS Finder, this box should be left unchecked. Leaving the box unchecked will also
speed up the export process as a Finder Window will not need to be called and displayed.

10. Close Document

If this box is checked, your file will be closed in PDFMarkz after the PNG file has been exported. By
Default this box is left unchecked and your file remains open in PDFMarkz until you manually decide to
close the file.
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11. Cancel Button

Clicking the Cancel button will cancel the PNG export action and close the PNG Export Pane. This will
take you back to the main File View Window in PDFMarkz.

12. Export Button

Clicking the Export button will export a PNG of the currently active file using the settings you have
selected in this Export PNG Panel. When you click on Export this will also bring up a Standard macOS
Finder window asking you where you would like to Save your PNG file.
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13.6. PDFMarkz Export As JPEG

Pages

1. All

Exports all pages in the document

2. Pages From X to X

Allows you to select a continuous range of pages to export.

Post Export

3. Open In

Selecting the Open In Checkbox allows you to select which application will handle the
exported JPEG file.

4. System Default Application

This is the default application your macOS system uses to handle JPEG files. On macOS systems
this is typically Apple’s Preview application.
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5. Specific Application Path

Selecting this radio button will enable the selection area.

6. Selection area

Click in the selection area to bring up a Standard macOS Finder window allowing you to navigate to
the application you wish to use to handle the exported JPEG file. If you wish to edit the JPEG, some
possible selections you would use on Mac would be Adobe Photoshop or Affinity Photo.

7. Suppress dialogs when possible

When this box is selected warning and error dialogs in applications the JPEG is sent too are
suppressed if possible.
When opening files in other applications, many times they pop up alert dialogs that require you to
click on something to continue. This can cause unwanted interference or halt in a workflow. The
downside of suppressing these dialogs is you may not know if problems were detected in the file.

8. Show in Finder

If this box is checked, when you perform the Export as JPEG action, once it is completed, your file will be
revealed in a Standard macOS Finder Window. Unless you need to interact with the file immediately after
export in the macOS Finder, this box should be left unchecked. Leaving the box unchecked will also
speed up the export process as a Finder Window will not need to be called and displayed.

9. Close Document

If this box is checked, your file will be closed in PDFMarkz after the JPEG file has been exported. By
Default this box is left unchecked and your file remains open in PDFMarkz until you manually decide to
close the file.

10. Cancel Button

Clicking the Cancel button will cancel the JPEG export action and close the JPEG Export Pane. This will
take you back to the main File View Window in PDFMarkz.

11. Export Button

Clicking the Export button will export a JPEG of the currently active file using the settings you have
selected in this Export JPEG Panel. When you click on Export this will also bring up a Standard macOS
Finder window asking you where you would like to Save your JPEG file.
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13.7. PDFMarkz Export As GIF

Pages

1. Pages All

Exports all pages in the document

2. Pages From X to X

Allows you to select a continuous range of pages to export.

3. Transparent Background

Solid White background areas are exported as transparent.

Note – gradients are not supported for this feature, only solid white areas, which are
typically the background of the page. (For example, black text on a white page exported
with a transparent background would export the white page background as transparent.)

!
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Post Export

4. Open In

Selecting the Open In Checkbox allows you to select which application will handle the exported GIF file.

5. System Default Application

This is the default application your macOS system uses to handle GIF files. On macOS systems this
is typically Apple’s Preview application.

6. Specific Application Path

Selecting this radio button will enable the selection area.

7. Selection area

Click in the selection area to bring up a Standard macOS Finder window allowing you to navigate to
the application you wish to use to handle the exported GIF file. If you wish to edit the GIF, some likely
apps you would use on Mac would be Adobe Photoshop or Affinity Photo.

8. Suppress dialogs when possible

When this box is selected warning and error dialogs in applications the GIF is sent too are
suppressed if possible.
When opening files in other applications, many times they pop up alert dialogs that require you to
click on something to continue. This can cause unwanted interference or halt in a workflow. The
downside of suppressing these dialogs is you may not know if problems were detected in the file.

9. Show in Finder

If this box is checked, when you perform the Export as GIF action, once it is completed, your file will be
revealed in a Standard macOS Finder Window. Unless you need to interact with the file immediately
after export in the macOS Finder, this box should be left unchecked. Leaving the box unchecked will
also speed up the export process as a Finder Window will not need to be called and displayed.

10. Close Document

If this box is checked, your file will be closed in PDFMarkz after the GIF file has been exported. By
Default this box is left unchecked and your file remains open in PDFMarkz until you manually decide to
close the file.

11. Cancel Button

Clicking the Cancel button will cancel the GIF export action and close the GIF Export Pane. This will
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take you back to the main File View Window in PDFMarkz.

12. Export Button

Clicking the Export button will export a GIF of the currently active file using the settings you have
selected in this Export GIF Panel. When you click on Export this will also bring up a Standard macOS
Finder window asking you where you would like to Save your GIF file.
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13.8. PDFMarkz Export Stories

Format
Select one of the three export formats from this menu.

1A. RTF

Selecting this option will export all of the story data in your file (all of the text) as an RTF file (Rich
Text Format). RTF files attempt to use the proper font, font color and font size.

1B. TXT

Selecting this option will export all of the story data in your file as a plain text file (.txt file). Text files
are strictly plain text with no formatting. These may be useful if you want to use the text in another
document.

1C. HTML

Selecting this option will export all of the story data in your file as a single html file that can be
opened in your web browser. Each story will be in its own section in the html file.
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Post Export

2. Open In

Selecting the Open In Checkbox allows you to select which application will handle the
exported story file. Make sure you select an app that can handle the output format you have selected
above. Selecting this Checkbox enables you to now select either the System Default Application or
Specific Application Path radio buttons.

3. System Default Application

This is the default application your macOS system uses to handle your exported files. On macOS
systems this is typically Apple’s TextEdit application for RTF and Txt files and your default web
browser for html files.

4. Specific Application Path

Selecting this radio button will enable the selection area.

5. Selection area

Click in the selection area to bring up a Standard macOS Finder window allowing you to navigate to
the application you wish to use to handle the exported story data. As an example you may want to
export a txt file (plain text) but always have it open in BBEdit. You would then select BBEdit in the
Selection area.

6. Suppress dialogs when possible

When this box is selected warning and error dialogs in applications the story data is sent too are
suppressed if possible. These dialogs would typically be things like missing fonts.
When opening files in other applications, many times they pop up alert dialogs that require you to
click on something to continue. This can cause unwanted interference or halt in a workflow. The
downside of suppressing these dialogs is you may not know if problems were detected in the file.

7. Show in Finder

If this box is checked, once the Export action is completed, your file will be revealed in a Standard
macOS Finder Window. Unless you need to interact with the file immediately after export in the macOS
Finder, this box should be left unchecked. Leaving the box unchecked will also speed up the export
process as a Finder Window will not need to be called and displayed.

If the Open In box is left unchecked, PDFMarkz will still export your story data, but will not
attempt to open the exported file. In addition, the System Default Application and
Specific Application buttons will not be available for selection.
*
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8. Close Document

If this box is checked, your file will be closed in PDFMarkz after the Export action has completed. By
Default this box is left unchecked and your file remains open in PDFMarkz until you manually decide to
close the file.

9. Cancel Button

Clicking the Cancel button will cancel the export action and close the Export Pane. This will take you
back to the main File View Window in PDFMarkz.

10. Export Button

Clicking the Export button will export the story data (text) of the currently active file using the settings
you have selected from the Format Menu. When you click on Export this will also bring up a Standard
macOS Finder window asking you where you would like to Save your exported file.
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14. PDFMarkz Preferences
• PDFMarkz General Preferences
• PDFMarkz Automation Preferences
• PDFMarkz IDML Preferences
• PDFMarkz Open In Preferences
• PDFMarkz Privacy
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14.1. PDFMarkz General Preferences

Show Welcome Window on Launch

When enabled the Welcome Window shows whenever you restart. If Disabled, no window will appear
when you startup PDFMarkz, so Drag-and-Drop is not immediately available, BUT, you can simply do a
Command-O to select a file.

Prefer Tabs when opening documents

Selecting this will open all documents in a single tabbed window. This may be helpful in keeping your
screen organized if you open several documents at one time. You can always remove a document from
the tabbed window by either dragging its tab outside the tabbed window or using the “move tab to new
Window” Menu item under the Window menu.

Show Inspector Panel

If this Preference is enabled, whenever you open a file in PDFMarkz, the Inspector Panel will
automatically open along with the file. If you open several files at one time and do not have the “Prefer
tabs when opening documents” Preference enabled, this could get a bit messy on screen. Once the file is

Tabbed Windows Requires macOS 10.12 or higher!
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open you can always tap Command-I to toggle the Inspector Panel on or off for that file.

Display Units

You can select a specific unit, or if you select “Document Settings”, PDFMarkz will display the page size
using the units the file was created with. By default this is set to “Document Settings”.

Animation Speed

Adjusts the time it takes to stabilize the display of a page when moving between pages of a multipage
document while Previewing a document. Some people prefer instantaneous previews when switching
between pages, some may prefer a slower transition similar to how pages on a smartphone may display.

Default Save/Open Path

• Previously Used – This setting affects both the Open and Export operations. Selecting this sets All
Open and Export dialogs to use the last path used for both the Open and Export features.

• Document Path – This setting affects only the Export operations. Selecting this during Export will
default to the same directory that contains the currently displayed document. Open Dialogs are not
affected by this setting and default to the Previously Used Path.

• Absolute Path – This setting affects both the Open and Export operations. Selecting this allows you
to specify a fixed path that will be used every time until you change this setting.

Reset Preferences (button)

Resets the PDFMarkz Preferences back to the factory default settings.
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14.2. PDFMarkz Automation Preferences

The automation section lets you set up certain actions to be performed whenever
you open a file in PDFMarkz.

A word of caution here – These preferences are manually set up and if you for instance set
up PDFMarkz to always open InDesign whenever you open a file, you may forget this is how
you last set the Preferences and the next time you use PDFMarkz, you may want to just
preview a file, but instead you find a delay that may be due to the automation kicking in or
multiple files being exported in different formats.

!
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On Document Open: Export

You can select one or multiple formats to export at one time.

• IDML
• PDF
• TIFF
• PNG
• JPEG
• GIF
• Stories

Export Path

Relative to input path – If you have a file format enabled in the On Document Open/Export Section,
these files will be stored in the same location as the original file

Absolute Path – If you have a file format enabled in the On Document Open/Export Section, and you
select the Absolute Path Radio button, you can then specify a custom path by clicking in the Choose an
Export Path dialog box. This will bring up a standard Finder window where you can select a custom path
to have your files saved upon export.

Rename to avoid overwriting – If this is enabled, PDFMarkz will rename exported folders that contain
the exported files. The exported files will always have the same name as the original document with a file
extension of the exported file type. To avoid overwriting, PDFMarkz will append a number to the end of
the folder name the exported file is saved in. Thus if you run the same file through PDFMarkz several
times and the file is named File.pdf and you export the file as a PNG, the second time you run this file
through PDFMarkz and have the output path set to the same output path as the first time you exported,
you will now have two folders, one named File_png and a second folder named File_png_1. Both folders
will contain a file named File.png.

On Export:

Open in Default Application – When this checkbox is enabled it also allows the following checkboxes to
be enabled –

– Suppress dialogs when available – When this box is selected warning and error dialogs in

To quickly disable Automation, simply uncheck every box in the top Export section so no file
formats are selected.*

Selecting multiple export formats may slow things down, especially if you select *Always
open IDML in: under the Post Export options.*
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applications the IDML is sent too are suppressed if possible. These dialogs would typically be things
like missing fonts and missing images.
When opening files in other applications, many times they pop up alert dialogs that require you to click
on something to continue. This can cause unwanted interference or halt in a workflow. The downside of
suppressing these dialogs is you do not know if fonts or images may be missing.

– Always open IDML in – If you have selected IDML as one of the Automation Preference Export
Options, and you enable this Preference, you have the option to Open that IDML in a specific version of
an application that can handle IDML files. If you select InDesign as the application to handle IDML files,
this requires InDesign CS4 or later, as CS4 was the first version of InDesign to support IDML. If you
select Affinity Publisher, this requires at least version 1.8 of Affinity Publisher. If you select Quark, this
requires at least QuarkXPress 2017 for IDML files to work (with Quark 2017 you need to make sure you
have the IDML Import XTension loaded. Quark 2018 and later ship with this XT by default)

– Always Open PDF in – If you have selected PDF as one of the Automation Preference Export
Options, and you enable this Preference, you have the option to Open that PDF in applications that
support PDF. The most likely candidate here being Adobe Acrobat DC, so that you can then annotate
the PDF.

Show in Finder

If this in enabled, your exported file will be shown in a Finder Window so you can directly access it upon
Export. This does not work on its own, at least one file format must be enabled under the Export section
for this to work.

Close Document

If Close Document is enabled, PDFMarkz will close the Preview of the document it creates after a
specified period of time (typically five seconds or less). This may help keep screen clutter to a minimum
depending on your personal preferences. This does not work on its own, at least one file format must be
enabled under the Export section for this to work.

When Open in Default Application is unchecked, and you have selected an export format,
your file will still be exported, but it will not be automatically opened in another application.*
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14.3. PDFMarkz IDML Preferences

Create Lo-Res Previews:

PDFMarkz gives you three choices for creating lo-res previews for your exported IDML files -

• Never (radio button 1)
• For missing images (radio button 2)
• For all images (radio button 3)

Link to Lo-Res (Checkbox)

IDML files do not contain preview data by default. PDFMarkz allows you to create Low
Resolution (Lo-Res) Previews of images for your IDML file. Thus, instead of seeing a gray
box where an image is, using this feature allows you to get a lo-res placeholder image as a
preview, making it easier to see what the document actually looks like without having to
relink images. You can then replace the lo-res previews at a later time with high resolution
images

*

When this preference is enabled and you have selected either Create Lo-Res Previews for
missing images or for all images, PDFMarkz will attempt to link to the previews it creates.*
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14.4. PDFMarkz Open In Preferences

These Preferences are targeted for handling PDF files and are used when you
click on the Open in Acrobat button in the application toolbar.

Open In Acrobat

Always use the System Default Application

By default the macOS always uses the latest install of Acrobat or Preview on your Mac as its Default
app to handle PDF files.

Always use a specific install

Selecting this radio button allows you to FORCE a specific application to always be used to open PDF
files. This is like Right-Clicking on your PDF file in the Finder and selecting an application to open it.
Selecting this Preference causes no IDML conversion to be attempted, instead, if this fails, you will
receive an error message from the application you selected to open the PDF file.

Please make sure if you select a custom application using Always use a specific install, it
can actually handle opening a PDF properly.*
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14.5. PDFMarkz Privacy

The Privacy settings are present to allow Users to either share or not share
anonymous analytical data with Markzware. By default this Preference is enabled.

By agreeing to share anonymous analytic data with Markzware, this allows us to plan for
resource usage as well as helps us prioritize new features that may be requested. We do
not share this data with anyone, it is strictly for internal use at Markzware.
*
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15. PDFMarkz Deactivate and Uninstall

Deactivating PDFMarkz

1. Make sure you are connected to the internet
2. With PDFMarkz Running, Click on the PDFMarkz Menu and then select About PDFMarkz

3. On the About PDFMarkz window click on the Deactivate button, this will bring up the Deactivate
PDFMarkz Window

4. On the PDFMarkz Deactivate Window, Click on the Deactivate button

Before Uninstalling PDFMarkz, please Deactivate it by using the following procedure!
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5. You should now see the PDFMarkz About screen with a message stating “Successfully Deactivated!”
and the PDFMarkz About Screen should show the Status as Freebie. In this mode PDFMarkz will only
Preview files.

6. You can now install PDFMarkz on another computer

To uninstall PDFMarkz -

1. Make sure PDFMarkz is not running
2. Navigate to the PDFMarkz.app file (normally should be in your Applications Folder)
3. Move PDFMarkz to the Trash
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4. Empty the Trash
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16. PDFMarkz Conversion Notes & Limitations
• PDFMarkz On Screen Preview Limitations
• PDFMarkz Layers
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16.1. On Screen Preview Limitations
PDFMarkz provides an on screen preview of documents you open. While we try and make the preview as
accurate as possible, there are features that may not appear correct in the on screen preview, but when an
IDML is exported or sent to another application it will be as accurate as possible. Due to the nature of PDFs
many things we take for granted in DTP/Layout apps are stripped out when a PDF is created and the PDF
itself is actually a series of drawing commands designed to recreate an accurate visual representation of the
original document. Some of the things not supported in PDF files are:

• Text Wrap or Runaround
• Paragraph Styles
• Character Styles
• Split/Span Column Text
• Tables

Thus, PDFMarkz makes intelligent guesses as to how to recreate these features to get as accurate a
representation of the original PDF as possible.

While the IDML PDFMarkz creates is a standard and valid IDML, each host app it is sent to
interprets IDML using its own method. Thus, you may see varying results in different host
applications. It is always prudent to review the file created in the host application from
the IDML out of PDFMarkz to make sure it is acceptable for your needs as is or
requires additional editing.

*
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16.2. PDFMarkz Layers
PDFs created in programs that support multiple items on sub-layers, when opened in PDFMarkz and sent
back to Quark as an IDML, now have all objects on the same layer as Quark does not support sub-layers.
The same PDF sent to InDesign or Affinity Publisher as an IDML still has items on the same Layer, but the
individual items are on sub-layers and thus can be edited as individual objects.
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16.3. PDFs created by placing scanned
images
PDFs created by placing scanned images will convert using PDFMarkz, however, since there was no
editable text in the original PDF, the InDesign document created will consist of pages with placed images
and thus no editable text in the InDesign document.

in order for conversions from PDF to InDesign using PDFMarkz to have editable text in the InDesign
document, the original PDF must have editable text. [and images of pages do not contain editable text.]

If you wish to extract the text out of a PDF that was created using placed images for page content instead of
actual editable text, you will need to use third party software that contains an OCR Engine (Optical
Character Recognition). OCR software scans images and looks for patterns that may match characters and
then creates a new file or layer and stores the characters the engine detects into that file or layer. While
OCR is usually not 100% accurate, in many cases it can extract a fairly accurate glob of text very close to
the original content.

Adobe Acrobat does contain an OCR engine.*
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17. PDFMarkz FAQs & Troubleshooting
Q. – I keep getting an error when attempting to Activate PDFMarkz. What’s the problem and how do I fix it?
A. – When you see the “Error attempting to activate!” message, this means the the email address and
License ID you are using do not match. The very first time you activate PDFMarkz, the email address you
use is locked to your License ID. The most common reasons for this issue are because people forgot which
email address they used to activate PDFMarkz, or they are entering an incorrect License ID.
First – Please confirm the License ID you are using to activate PDFMarkz is actually the License ID you
received when you ordered PDFMarkz. If you still have the email that came with your order, try copying and
pasting the License ID directly from the email.
Second – If you use more than one email address, try using your alternate email address and see if
PDFMarkz activates. If it does, then please make note this is the email address you need to use in the
future to activate PDFMarkz.
If neither of the tips above work please fill out our online Tech Support Form and make sure and provide
the License ID and email address you are using to try and activate PDFMarkz. This way we can attempt to
look up one or the other and see if we can figure out what is going on.

Q. – When I try and export files from PDFMarkz a popup window comes up telling me the feature is
restricted?
A. – When you first install PDFMarkz it is in Freebie mode. In Freebie mode you can only Preview
documents. In order to use export and other advanced features, you must activate PDFMarkz. This
requires purchasing a license for PDFMarkz and using it to activate your product.

Q. – Why does PDFMarkz use a PDF file when I click on the Open in Publisher icon?
A. – In order to send Affinity Publisher an IDML file instead of a PDF, you must be using Affinity Publisher
1.8 or higher. If you are running Affinity Publisher 1.7 or earlier, PDFMarkz will send a PDF to Affinity
Publisher as Affinity Publisher 1.7 and below do not have support for IDML import.

Q. – Every time I try and convert my PDF to Affinity Publisher by clicking on the Open In Publisher button,
Affinity Publisher crashes.
A. – We have encountered this issue while testing PDFMarkz in house. How we resolved this issue was to
go to the Security & Privacy Preference and under the Files and Folders area, enable Documents Folder
and Desktop Folder for Affinity Publisher.app.
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18. PDFMarkz Release Notes
Check out release notes and see what has been added, improved and fixed.

PDFMarkz Release Notes
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